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Tutorial

ROTATE Guided Tour

This chapter provides a brief overview of the ROTATE program. It then leads you
through a short tutorial to introduce you to the basic functions of ROTATE. After you
have completed this chapter, you will be able to perform the steps to import and begin to
analyze data in ROTATE.

This tutorial uses the demonstration data that is automatically installed with ROTATE.
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1 Using ROTATE

Using ROTATE

ROTATE Tutorial

Starting the Software

To start ROTATE, click Start, point to Programs, then to ROTATEZ2, then click ROTATE2.
The ROTATE program window appears.
To stop ROTATE, simply choose Exit from the File menu.

The ROTATE User Interface

ROTATE follows the standard Windows® user interface standards, and consists of the usual win-
dows, menus, and toolbars. A picture of the ROTATE window appears below.

Title bar £~ vSIRotate? |_[O] x]
Menu bar File Edit Wew Channels Analysis ‘Window Help
Toolbar™— | | p| & | BB | el@le=] 2| ol 6
Channel List -
Window
Status bar For Help, press F1 7

¢ The title bar displays the program name.

« The menu bar appears directly below the title bar. It contains the menus of commands for the
program.

e The toolbar appears directly below the menu bar. It contains the tool buttons that are shortcuts
to the most often used functions of the program. A short ToolTip describing the button func-
tion appears when you move the mouse pointer over a button. You can click and drag a toolbar
to any position within the program window, and “dock” it to any side of the window. You can
also show or hide any toolbar with the commands on the View menu.

¢ The status bar shows a brief description of the current command or button under the mouse
pointer.

« Many parts of the program have right-click menus. For example, you can right-click on a plot
window to display a menu of functions for that plot.

¢ The Channel List window shows the channels (tachometer and data) that you have imported
into, or created in, ROTATE. To toggle the display of the Channel List window, right-click
anywhere in the ROTATE program window (except on the menu bar).
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For Help, press F1 i

e The online help describes each command, dialog box, and plot. To display the online help, do
one of the following:

* Highlight a command on a menu and press F1. This displays an explanation of the com-
mand.

¢ Open adialog box and press F1. This displays an explanation of the controls in the dialog
box.

« Make a plot window active by clicking on the plot and press F1. This displays a descrip-
tion of the functions available for that plot.

Setting Your Preferences

The preferences settings control the default ROTATE appearance and functions. These include the
following defaults.

¢ Frequency units in plots

e Waterfall plot type (waterfall or contour)

¢ Default time increment and sampling frequency

« Automatic plot display after analysis

« Creation of Torsional analysis files when processing a tachometer signal
¢ The directory for the files created by the ROTATE analysis functions
To set your preferences, follow these steps.

1. Start ROTATE. See “Starting the Software” on page 8.

2. From the Edit menu choose Preferences.

Default waterfall plat type

' Contaur

Cancel
& Waterfall 4|

Defaulttime increment: ID-UUU5
Sampling frequency: 2000

vV Automatic plotting after analysis

v Create degrees torsion file during tachometer processing

IV Create degrees per second torsion file during tachometer processing
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3 Starting ROTATE and Displaying Channels

3. Inthe Preferences dialog box, select or enter the desired defaults. Press F1 for a description of
the options.

4, Choose OK when finished.

Starting ROTATE and Displaying Channels

The first section of the Tutorial leads you through starting ROTATE, as well as opening a data file
and displaying data channels in the file.

Start ROTATE

1. To start ROTATE, click Start, point to Programs, then to ROTATE, then click ROTATE. The
ROTATE program window appears.

&7 ¥SIRotate2 !E m
File Edit Yiew Channels Analysis Window Help
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For Help, press F1 i

View the Channel List

When ROTATE starts, it displays the Channel List window on the left side of the application.
Hint: Don’t worry if the Channels List window is empty, or contains different files than the ones shown

in the picture. Adding files to the Channel List window is described below.
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For Help, press F1 i

2. You can hide the Channel List window by clicking anywhere on the ROTATE window by
pressing Esc, or by clicking on the small “x” in the upper right corner of the Channel List win-
dow.

3. You can restore the Channel List window by doing one of the following:
¢ Right-click on the ROTATE window.

ROTATE Tutorial
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*  Press Ctrl+L.
»  Click the Channel List button .

¢ From the Channels menu choose Channel List Window.

Remove entries from the Channel List

Removing entries from the Channel List window does not delete any data, and you can add the
data files back in at any time.

4. Select the demo data file in the Channel List by clicking the topmost entry in the channel list.

&= Rotate [_ O] x|
File Edit Yiew Channels Analysis Window Help
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Selected entry

For Help, press F1 i

5. Press Del.

Note that you can only only remove entries which represent data files. You cannot remove a chan-
nel from within a data file.

Hint: You can also right-click a channel and choose Remove. Note that this removes all selected entries,
not just the one you right-clicked. You can also select more than one entry in the list by holding
down the Ctrl key and clicking additional entries. If you hold down the Shift key, you can and
select a range of entries

Add a Data File

Adding a data file displays all the channels of data from that file. ROTATE can display the chan-
nels from a number of different file formats.

6. Right-click on the Channel List and choose Add File

7. Select the correct Files of type. If you don't know the file type, select All Files (*.*). For this
example, select Medallion File (*.mrd).

Lok jr: I A VS| Rotate 2 j gl

Demo_DataMRD

File name: I

Filez of type: IMedaIIion Filez [*.mrd) j Cancel |

8. Select the Demo_Data.MRD file and choose Open. The data file along with its channels will
appear in the Channel List.
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5 Displaying Data and Processing a Signal

Hint: You can also do one of the following to add a file:

e Click the Add File button .

¢ From the Channels menu choose Add File.

Displaying Data and Processing a Signal

The second section of the Tutorial leads you through displaying a time waveform plot. It then
describes the steps to process a tachometer signal to get the instantaneous machine speed in RPM
(revolutions per minute).

The Demo_Data.MRD file contains two channels.
¢ Channel 1 is a time waveform of a pulse tachometer signal varying between 0 and 4 \olts.

e Channel 2 is a time waveform from a vibration sensor.

Plot a Time Waveform

1. Make sure that Channel 1 is the only selected channel in the Channel List window. If you do
not see the channels, click on the + marker to the left of the data file entry to display its chan-
nels. Then right-click Channel 1 and choose Plot. You can also do one of the following:

e Select the channel and click the Plot button .
¢ Double-click the channel.
¢ Select the channel and choose Plot from the Channels menu.

ROTATE displays a plot of the time waveform.

Echannel 1 - Demo_Data. MRD =1 E3 I
_

Channel 1 - Demo_Data. MRD

X0
Amplitude (Wolts): -570m

Amplitude (Wolts)

Seconds

Zoom in on the Time Waveform
2. Right-click the plot and choose Zoom.

ROTATE Tutorial
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3. Click and drag the mouse over a part of the plot to enlarge that part of the plot.

Echannel 1 - Demo_Data. MRD =1 E3
_
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to zoom
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v
0

Seconds

The plot redraws the zoomed part when you release the mouse button. Note the signal ampli-
tude is from -0.5 to 4 Volts.
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4. Right-click the plot and choose Auto-scale to show the whole signal again.

Process a Tachometer Signal

Channel 1 should still be selected in the Channel List window. Channel 1 is a tachometer signal, so

you can process it to get the instantaneous RPM. You do not have to display the Channel List win-
dow again.

5. Click the Tachometer Processing button . You can also choose the Tachometer Processing
command from the Analysis menu.

6. Make sure the Trigger Level is between 1 and 4 \olts. In general, the trigger level should be in
the middle of the amplitude of the tachometer signal for a pulse tachometer. Choose OK to
process the tachometer signal.

Tachometer Processing E
— Tachometer type——————————— [~ Trggering———————
&+ Pulse Slape = -
©oc & Positive Cancel |
' Megative

— Tachameter conversions
EPk fvalt:

Trigger level [voltz]: |1—
I‘I Spline segments: |40—j
RPM at 0 volts: ID Shave percentage: ID—
Pulzes/revalution: |1 Hald aff: ID—
Huysteresis: IU—
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Displaying Data and Processing a Signal

Click and drag the part
to zoom

ROTATE Tutorial
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ROTATE displays a plot of the machine RPM. There are actually two curves on the plot. One
line is the smoothed (spline-fit) RPM curve. The other line is the Raw RPM curve before
ROTATE applied the spline-fit to smooth the RPM curve.

Zoom in on the peak of the RPM curve to see the two curves. Right-click the plot, choose
Zoom, then click and drag over the region you want to zoom.
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The smooth curve is the spline-fit RPM curve, while the jagged curve is the raw RPM curve
before smoothing.

Click the Channel List button or press Ctrl+L to display the Channel List window. Note
that there are two new generated files in the Channel List, each with one channel. ROTATE
created and saved these files in the Results directory (see “Manage Files” on page 16 to set the
Results directory). Note that as the data in “Channel 1” was used to create these files, they will
appear as child entries under the entry for “Channel 1”.

e The smoothrpm0.spl file is the smooth (spline-fit) RPM data.
e The rpmO.raw file is the Raw RPM data.
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Other Types of Analyses

You can perform many other types of analyses in ROTATE to assist in diagnosing a variety of dif-
ficult problems.

» Refer to Chapter 3 “ROTATE Applications” for more information on the different types of
analyses and their uses.

» Refer to Chapter 4 “ROTATE Plotting Features” for more information on using the plotting
functions to manipulate plots.

Exporting a Channel and Managing Files

he third section of the Tutorial describes the process of exporting a channel to a Universal File
Format (UFF) file. It also describes channel and file management. ROTATE can generate a large
number of files during an analysis, and it is important to manage them so that you do not fill up the
ROTATE directory with unnecessary files.

Export a Channel to a UFF File
Exporting a channel to a UFF file provides 2 useful functions:
e It creates a new ASCII or binary data file in a widely-accepted format.

< Itallows you to export only a part of the file instead of the entire file. For example, the original
file might contain 6 hours of data, but you can export just the 5 minutes of data that contain the
desired event.

1. Right-click a channel and choose Export to File...

Export Channel to UFF: Channel 1 E

File name:

I Browse... | — |

" Export Entire Trace

& Export Time Bange

Stark time: ID zeC,
End time: |1 F.0000 zeC,
™ Binary format

2. Enter the file name and choose Browse to select the directory. Choose Export.
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